TouchPAD

TPD/VPD Series HMI Devices
Getting Started

Version: 1.0.5  April 2012

Usage information for
TPD-280
TPD-280U
TPD-283
TPD-430
TPD-430-EU
VPD-130
VPD-130N
Warranty

All products manufactured by ICP DAS are under warranty regarding defective materials for a period of one year, beginning from the date of delivery to the original purchaser.

Warning

ICP DAS assumes no liability for any damage resulting from the use of this product. ICP DAS reserves the right to change this manual at any time without notice. The information furnished by ICP DAS is believed to be accurate and reliable. However, no responsibility is assumed by ICP DAS for its use, nor for any infringements of patents or other rights of third parties resulting from its use.

Copyright

Copyright @ 2012 by ICP DAS CO., LTD. All rights are reserved.

Trademarks

Names used for identification only may be registered trademarks of their respective companies.

Contact US

If you have any questions, please feel free to contact us. We will give you a response within about two working days.

Email: service@icpdas.com
service.icpdas@gmail.com
# Table of Contents

Chapter 1. Introduction ......................................................................................... 1
  1.1 Hardware Specifications .............................................................................. 2
  1.2 Hardware Overview ..................................................................................... 3

Chapter 2. Software Installation ........................................................................ 7
  2.1 Install the HMIWorks Software ................................................................ 7
  2.2 Create a New Project .................................................................................. 8
  2.3 HMIWorks Working Environment .............................................................. 10
  2.4 Downloading Methods for TouchPAD ...................................................... 11

Chapter 3. Demo Programs .................................................................................. 14
  3.1 Demo 0 (Beep & Count, using Ladder Designer) ....................................... 14
    3.1.1 HMI Page Design .................................................................................. 15
    3.1.2 Device Setup (TouchPAD) .................................................................... 24
    3.1.3 Download a Project .............................................................................. 25
  3.2 Demo 1 (Beep, Timer, Counter) ................................................................. 26
    3.2.1 HMI Page Design .................................................................................. 26
    3.2.2 Device Setup (TouchPAD) .................................................................... 33
    3.2.3 Download a Project .............................................................................. 34
  3.3 Demo 2  (Remote I/O: Light, Temperature, Communication Detector) .... 35
    3.3.1 HMI Frame Design .............................................................................. 36
    3.3.2 Editing an LD Program using “Ladder Designer” ................................. 45
    3.3.3 Device Setup (TouchPAD) .................................................................... 48
    3.3.4 Download the Project .......................................................................... 48
  3.4 Demo 3  (Multi HMI with ISaGRAF PAC: Light, Temperature, 
              Communication Detector) ................................................................. 50
    3.4.1 HMI Frame Design .............................................................................. 52
    3.4.2 Using “Ladder Designer” to edit an LD Program ................................. 57
III

3.4.3 Device Setup (TouchPAD) ................................................................. 60
3.4.4 Download the Project ................................................................. 62

3.5 Demo List ....................................................................................... 64

Appendix A. Downloading Information .......................................... 65
Appendix B. Configuring the I/O Module .......................................... 66
Appendix C. Creating Your Own GUI ................................................. 71
Appendix D. Configuring and Programming the ISaGRAF PAC .... 72
Appendix E. Displaying the Decimal Point ....................................... 75
Appendix F. Using USB to Download a Program .......................... 77
Chapter 1. Introduction

The TPD-280/280U/283/430/430-EU and VPD-130/130N devices are part of the TouchPAD series that includes a tiny touch HMI interface and are designed for building and home automation. The TouchPAD series is equipped with a high resolution TFT color touch screen and can be installed using a regular electrical wall-mount outlet. The TouchPAD series can also be seamlessly integrated with rich I/O modules and provides a beautiful, flexible and customized screen display. In short, the TouchPAD series is the best choice when upgrading from the mechanical switches to intelligent control pads.

For PLC users, the HMIWorks utility includes Ladder Designer, and for IT users, a C language environment is provided. It takes less than 30 minutes to learn how to create an application for a TouchPAD device when using Ladder Designer. ICP DAS also provides redundant solutions for TouchPAD HMI devices in our PoE version, TPD-283. With all the features provided, TouchPAD touch HMI devices are possibly the most cost-effective HMI device solution that has been created.

Note: The usage of the TPD-280U, TPD-430 and TPD-430-EU is the same.

TouchPAD:

| TPD Series (2.8” Touch Screen) | TPD Series (4.3” Touch Screen) | VPD Series (3.5” Touch Screen) |
1.1 Hardware Specifications

If you are interested in learning more about the hardware specifications for the various TouchPAD models, please refer to our website:
www.icpdas.com.tw > Product > Solutions > HMI & Touch Monitor > TouchPAD
or
1.2 Hardware Overview

TPD Series

TPD-280:

- Power/GND/RS-485
- Rotary Switch (0 ~ 9)
  - 0: Run Only
  - 1: Update Only

TPD-280U:

- USB
- 2.8” TFT LCD with Touch Panel

0: Run
1: Update OS
9: Update AP
**TPD-283:**

- Ethernet (PoE)
- Rotary Switch (0 ~ 9)
  - 0: Run and Update
  - 1: Force Update (When the program is damaged)
  - 2: Run Only

**Reset TouchPAD Button**

1. Open the Top Cover
2. Locate the Reset Button
3. Press the Reset Button to perform the desired action.
**TPD-430; TPD-430-EU:**

The difference between the TPD-430 and the TPD-430-EU is the size of the appearance, which is divided into U.S. gauge and European gauge.

**TPD-430:**
- Rotary Switch (0 ~ 9)
  - 0: Run
  - 1: Update OS
  - 2: Update AP
- USB
- Power/GND/RS-485

**TPD-430-EU:**
- 4.3” TFT LCD with Touch Panel
- Reset Button (Left hand Side)
- Programmable LED Indicator
- Speaker
- USB
VPD Series

**VPD-130:**
- LED Indicator
- Rubber Keypad
- RS-485
  - Data- Data+
- RS-232
  - TxD RxD GND
- Power/GND
- Reset Button
- Rotary Switch (0 ~ 9)
  - 0: Run
  - 1: Update OS
  - 9: Update Program
- USB

**VPD-130N:**
- 3.5” TFT LCD with Touch Panel

---

TPD/VPD Series - Getting Started v.1.0.5

Copyright@ 2012 ICP DAS CO., LTD. All Rights Reserved.  E-mail: service@icpdas.com
Chapter 2. Software Installation

First, install the HMIWorks development software on your PC. To download the latest version, visit the website at: http://ftp.icpdas.com/pub/cd/touchpad/setup/

2.1 Install the HMIWorks Software

Step 1: Double click the execution file to install the HMIWorks software.
   (This manual uses V2.01 beta5)

Step 2: Follow the instructions in the setup wizard and click “Finish” to complete the installation.
2.2 Create a New Project

Step 1: After the HMIWorks software has been successfully installed, select [ Start ] > [ All Programs ] > [ ICPDAS ] > [ HMIWorks_Standard ] > [ HMIWorks Standard Edition ] to execute the software.

(Note: If the Windows Security Warning dialog appears in Windows 7, please click “Unlock”.)

Step 2: Select the “New Project” icon to create a new project.
Step 3: Select the TouchPAD model name (a), enter a project name (b) and it’s the location where the project should be saved (c), then select the display orientation (d) and the default programming type (e), and click “OK”.

NOTE: If the TouchPAD model selected is incorrect, it will cause errors in the program and will mean that the project cannot be downloaded.
2.3 HMIWorks Working Environment

Toolbox:
2.4 Downloading Methods for TouchPAD

**TPD-280** (Applications are downloaded through **RS-485**.)

- **I-7561, USB/RS-485 Converter**
- **Power supply, DP-665, 24V**
- **RS-485 (Data+, Data-)**
- **VDC (+10 ~+30 VDC)**
- **Ground**
- **USB**
- **PC**
- **TPD-280**

**TPD-283** (Applications are downloaded through **Ethernet**.)

- **PoE Switch NS-205PSE**
- **Power supply KA-52F-48**
- **Power**
- **Internet**
- **Ethernet**
- **TPD-283**
- **ET-7000/PET-7000**

**Note**: Either “Ethernet” or “PoE” uses the same common Ethernet cable.

**PoE**, power over Ethernet, means that the Ethernet cable conveys not only data but also power.
TPD-280U (Applications are downloaded through USB only.)

I-7561, USB/RS-485 Converter

Power supply, DP-665, 24V

TPD-280U

USB

PC

Frame Ground

RS-485 (Data+, Data-)

VDC (+10 ~+30 VDC) and Ground

TPD-430/TPD-430-EU (Applications are downloaded through USB only.)

I-7561, USB/RS-485 Converter

Power supply, DP-665, 24V

TPD-430/TPD-430-EU

USB

PC

Frame Ground

RS-485 (Data+, Data-)

VDC (+10 ~+30 VDC) and Ground
VPD-130/VPD-130N (Applications are downloaded through USB only.)

I-7561,
USB/RS-485 Converter

RS-485
(Data+, Data-)

USB
PC

VDC (+10 ~+30 VDC)
and Ground

VPD-130/VPD-130N

Power supply,
DP-665, 24V

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
DP-665, 24V

USB/RS-485 Converter

VDC (+10 ~+30 VDC)
and Ground

USB

Frame Ground

Earth

Power supply,
Chapter 3. Demo Programs

In this chapter, you will be detailed instructions in how to write simple demo programs in either the C or LD language. Before beginning programming, please ensure that both the hardware and the software are installed (Chapter 2).

3.1 Demo 0 (Beep & Count, using Ladder Designer)

Demo 0 is programmed using the Ladder Designer and implements a single button that will beep when clicked on and will increase the counter by one. The counter will reset to zero when it reaches to ten.

Hardware Devices
TPD-280 is used for demo 0

---

More information about downloading the driver for the I-7561 module, together with the hardware configuration for I/O modules, please refer to Appendix A and Appendix B.
3.1.1 HMI Page Design

Step 1: Create a new TPD-280 project based on the Ladder Designer (refer to Section 2.2 for more details).

Step 2: Create a “BitButton” (picture button).

a. Switch to the “Toolbox” tab, as shown in the picture below.
b. Click the “Widget (Ctrl+2)” heading to unfold the “Toolbox” panel.
c. Select the “BitButton” icon, then move your mouse to the design area. You will notice that the cursor becomes a “+”.
d. In the design area, click and drag the mouse to draw a rectangle.
Step 3: In the same manner as the previous step, click on the “Label” icon and create a “Label” (text display) in the design area.

“Label”, a Widget component, can be used for either text or control functions. However, the “Text” component can only be used for text display.

Step 4: Create 2 tags, “beep_tag” and “count”.

a. As shown in the picture below, right click the “Virtual” in the Workspace to create the tags.

b. Enter the name of the tag in the “Edit variable” window. Here we use “beep_tag” for
the first tag and “count” for the second.

c. Finally, we can see that the 2 tags created in the Workspace.

Step 5: Configure the properties for the “BitButton” component.

a. Select the “BitButton” component in the design area.

b. Click the “Text” field in the Properties Inspector panel and enter the string “Click Me”.

c. Click the “Font” field to change the font to a suitable style, size and color.
d. Click on the “TagName” property in the Inspector and there shows a little button “…”. Click on the “…” button.

e. Select the tag you want. Here we select the tag, “beep_tag”, for the BitButton.

f. Finally, we can see the tag we just choose.

Step 6: Configure the properties for the “Label” component.

a. Select the Label component in the design area.
b. The following properties can be modified from the Properties Inspector area on the right hand side:

- **Alignment**: Sets the text alignment position in the display box of the “Label” component.
- **FillColor**: Sets the fill color for the display box of the “Label” component.
- **Font**: Sets the font for the text in the display box.
- **Height**: Sets the height of the display box.
- **ID**: A unique ID number to identify different entities of the same type in the design.
- **Left**: Sets the X-coordinate of the top left corner of the display box.
- **Name**: The type name of the component.
- **OutlineColor**: Sets the outline color of the display box.
- **Text**: Sets the text to be displayed in the display box.
- **Top**: Sets the Y-coordinate of the top left corner of the display box.
- **Width**: Sets the width of the display box.

b. Select “TagName” as “count”. (It is similar to set “TagName” as the above step.)

c. Select “TagName” as “count”. (It is similar to set “TagName” as the above step.)

### Step 7: Use the Ladder Designer to program the logic – the first rung.

a. Click the menu [HMI] > [Ladder Designer].

b. Press the F2 button (or F2 key on the keyboard) to create a new rung.

c. Move the cursor (the highlighted rectangle) to the first contact symbol and then press F7 to add a new function block to the right of it.
d. Double-click on the function block to set the function to it. Here we set it the function, “increment”, of the category, “math”.

![Function Block]

e. Move the cursor to the function block of “inc” and then press the F7 button again to add a new function block to the right of it.

![Function Block]

f. Double-click on the second function block to set the function to it. Here we set it the function, “Beep”, of the category, “system”.

g. Double-click on the contact symbol to select variable “beep_tag”.

![Select variable]
h. Similarly, double-click on the neighborhood of the input parameter “in” as below figure to select variable “count”.

i. Finally, the first rung is done.

![Diagram](image)

j. The first rung does the followings:

```c
if( beep_tag == 1 ) //that is, when the BitButton is pressed.
{
    Beep(); //make a beep sound
    count = count + 1; //increment the count
}
```

**Step 8: Use the Ladder Designer to program the logic – the second rung.**

a. Similar to Step 7. Move the cursor to an empty position and then press the F6 button to add a new rung with a function block.

b. Move the cursor to the previously-created function block and then press the F7 button to create a new function block to the right of the first one.

c. Double-click on the first function block to set its function to “GE” (greater than or equal to) of the category, “default”.

d. Double-click on the second function block to set its function to “Assign” of the category, “default”.

e. Set the value of the parameter “in2” of the function “GE” (>=) by double-clicking on the neighborhood of the parameter “in2”.

f. To enter a constant to a parameter, click on the tab “Enter Constant” in the “Select variable” window. Here we enter 10.

g. Similarly, set the parameter “in” of the function “Assign” to zero.

h. Similarly, select “count” to parameter “in1” of the function “GE” (>=).

i. Similarly, select “count” to the parameter “out” of the function “Assign”.
j. The second rung does the followings:

```
if( count >= 10 )
{
    count = 0;  //set the count to zero
}
```

Step 9: Save and Close (the Ladder).

Step 10: Tune the scan time if necessary.

a. Click the menu [HMI] > [Refresh Time (I/O Scan)] to set the scan time.

b. The default scan time is 100 ms. The scan time is the time interval between two consecutive Ladder scan. That is, TouchPAD executes each rung of the ladder serially from the first rung to the last and after finishing the last rung, it waits until the scan time interval is up (the scan time interval is calculated from the time of the first rung’s execution) to execute from the beginning (the first rung) again.

c. The scan time might influence the feeling of sensitivity. If the scan time is too small, touching the BitButton on the screen one time may causes it triggering many times and thus makes the counter increment more than one.
3.1.2 Device Setup (TouchPAD)

Step 1: Click the function menu [ Run ] > [ Setup Device (TouchPAD) ].

Step 2: From the dialog box, select the appropriate “COM” port number and click “OK”.

In this example, we have set “COM3” of the PC to use I-7561 (convert USB to RS-485). The users should set the appropriate COM port for their PC. To determine the COM number used by your PC, please verify it using the “Device Manager” from the control panel of your PC.

Note: If the OS used on your PC is Windows 7, and there are no COM port options displayed in the “Setup Serial Device” dialog window, please exit the software and right click on the “HMIWorks_Standard” icon on the PC desktop then select “Run as Administrator” to execute the software.
3.1.3 Download a Project

After completing the HMI page design stage, download the project to your TouchPAD device.

Step 1: Turn the Rotary Switch on the back panel of the TPD-280 to “1”, and then reset the TouchPAD device.

Refer to Section 1.2 Hardware Overview for more details. (The TPD-280 screen will turn dark after it is reset.)

Step 2: Select [ Run ] > [ Rendering and Build ] in the HMIWorks menu to compile and make the project.

Step 3: Select [ Run ] > [ Download Only ] to download the project.

Step 4: After the project downloaded, turn the Rotary Switch of the TPD-280 to “0” and reset the TouchPAD device.

Refer to Section 1.2 Hardware Overview for more details.
(The TPD-280 will display the HMI screen after it is reset.)
3.2 Demo 1 (Beep, Timer, Counter)

Demo 1 is programmed using the C language and implements a single button that will beep when clicked on and will increase the counter by one. Demo 1 also implements a second counter that will increase each second and then reset itself to zero when it reaches 100 seconds.

Hardware Devices:
TPD-280 is used for demo 1

For more information about downloading the driver for the I-7561 module, together with the hardware configuration for I/O modules, please refer to Appendix A and Appendix B.

3.2.1 HMI Page Design

Step 1: Create a new TPD-280 project based on the C language (refer to Section 2.2 for more details).
Step 2: Create a “BitButton” (picture button).

a. Switch to the “Toolbox” tab, as shown in the picture below.
b. Click the “Widget (Ctrl+2)” heading to unfold the “Toolbox” panel.
c. Select the “BitButton” icon, then move your mouse to the design area. You will notice that the cursor becomes a “+”.
d. In the design area, click and drag the mouse to draw a rectangle.
Step 3: In the same manner as the previous step, click on the “Label” icon and create a “Label” (text display) in the design area.

“Label”, a Widget component, can be used for either text or control functions. However, the “Text” component can only be used for text display.

Step 4: Create a “Timer” and a “Label”.

a. As shown in the picture below, click the “System (Ctrl+3)” heading to unfold the “Toolbox” panel.
b. Select the “Timer” icon, then move your mouse to the Frame1 design area. You will notice that the cursor becomes a “+”.
c. Click in the design area to create a Timer icon.
d. In the same manner as that described in the Step 3, create another “Label”, as illustrated in the picture below.
Step 5: Configure the properties for the “BitButton” component.

a. Select the “BitButton” component in the design area.
b. Click the “Text” field in the Properties Inspector panel and enter the string “Click Me”.
c. Click the “Font” field to change the font to a suitable style, size and color.

Step 6: Edit the control codes for the “BitButton” component.

a. Double click the “BitButton” component in the design area to open the programming window.
b. Edit the code in the programming window using the C language. (Users can copy the code from the picture below.) In this demo, each click of the button will add 1 to the counter and beep once until it reaches 100, and will then reset to 0 before beginning to accumulate again.
c. When finished, click “Save & Close” from the File menu.

Step 7: Configure the properties for the “Label” component.

a. Select a Label (“LabelWidget5” or “LabelWidget7”).

b. Declare the variables

c. Convert the integer to a string in order to display it on the Label.

d. Beep function

This name must be the same as the “Name” and “ID” properties of the Label.
b. The following properties can be modified from the Properties Inspector area on the right hand side:

**Alignment:** Sets the text alignment position in the display box of the “Label” component.

**FillColor:** Sets the fill color for the display box of the “Label” component.

**Font:** Sets the font for the text in the display box.

**Height:** Sets the height of the display box.

**ID:** A unique ID number to identify different entities of the same type in the design.

**Left:** Sets the X-coordinate of the top left corner of the display box.

**Name:** The type name of the component.

**OutlineColor:** Sets the outline color of the display box.

**Text:** Sets the text to be displayed in the display box.

**Top:** Sets the Y-coordinate of the top left corner of the display box.

**Width:** Sets the width of the display box.

---

**Step 8: Configure the properties of the “Timer” component.**

a. Select the “Timer6” component in the design area as shown in the picture below.

b. Set the “Interval” property in the Properties Inspector area. The units are milliseconds (ms), so if the control function is to be executed every 1 second, set the value as “1000”.

---

![Diagram of Timer component](image-url)
Step 9: Edit the control codes for the “Timer” component.

a. Double click the “Timer6” component in the design area to open the programming window.

b. Edit the code in the programming window using the C language. (The User can copy the code from the picture below.) In this demo, the counter will increase by 1 each time the button is clicked until it reaches 100, and will then reset to 0 before beginning to accumulate again.

c. When finished, click “Save & Close” from the “File” menu.

```c
long cnt1=0;
long auto_cnt1=0;
static char str1[32];

void Timer6OnExecute(tWidget *pWidget)
{
    auto_cnt1=auto_cnt1+1;
    if (auto_cnt1>100)
    {
        auto_cnt1=0;
    }
    usprintf(str1,"%d",auto_cnt1);
    LabelTextSet(&LabelWidget7,str1);
}
```

Step 10: The configuration for Demo 1 has been completed. Click [File] > [Save] to save the file.
3.2.2 Device Setup (TouchPAD)

Step 1: Click the function menu [Run] > [Setup Device (TouchPAD)].

Step 2: From the dialog box, select the appropriate “COM” port number and click “OK”.

In this example, we have set “COM3” of the PC to use the I-7561 (convert USB to RS-485). The users should set the appropriate COM port for their PC. To determine the COM number used by your PC, please verify it using the “Device Manager” from the control panel of your PC.

Note: If the OS used on your PC is Windows 7, and there are no COM port options displayed in the “Setup Serial Device” dialog window, please exit the software and right click on the HMIWorks_Standard icon on the PC desktop then select “Run as Administrator” to execute the software.
### 3.2.3 Download a Project

After completing the HMI page design stage, download the project to your TouchPAD device.

**Step 1:** Turn the Rotary Switch on the panel of the TPD-280 to “1”, and then reset the TouchPAD device.

Refer to [Section 1.2 Hardware Overview](#) for more details. (The TPD-280 screen will turn dark after it is reset.)

**Step 2:** Select [ Run ] > [ Rendering and Build ] in the HMIWorks menu to compile and make the project.

**Step 3:** Select [ Run ] > [ Download Only ] to download the project.

**Step 4:** After the project downloaded, turn the Rotary Switch of the TPD-280 to “0” and reset the TouchPAD device.

Refer to [Section 1.2 Hardware Overview](#) for more details.

(The TPD-280 will display the HMI screen after it is reset.)
3.3 Demo 2

(Remote I/O: Light, Temperature, Communication Detector)

Demo 2 is designed using the LD language and creates two HMI frames:

Frame1:  
- Light display/control (DI/DO) x 8,
- Temperature display (I-7018Z ch0) x 1
- Communication detector (I-7055, I-7018Z) x 1
- Frame switch x 1

Frame2:  
- Scene picture x 1
- Control button x 1
- Light control (DO) x 2
- Frame switch x 1

Hardware Devices

TPD-280, I-7055D, and I-7018Z are used for demo 2

Power Supply (DP-665, 24V)

USB/RS-485 Converter (I-7561)

TPD-280

I-7055D
(8 DI, 8 DO Module)

I-7018Z-G/S
(10-ch. Thermocouple Input Module with High Voltage Protection)

NET-ID (Address): 1

Power

NET-ID (Address): 2

Baud Rate: 19200 bps
Checksum: Disabled

RS-485 (Data+)

RS-485 (Data-)

K-Type wire

USB

GND

Power (+10~30 Vdc)

Frame Ground

Power Supply (DP-665, 24V)
3.3.1 HMI Frame Design

Step 1: Create a new TPD-280 project based on LD (refer to Section 2.2 for more details).

Step 2: Set up the connection.

a. Right click the “Connection” item in the “Workspace” tab and select the “New Connection” option to set up the connection.

b. For this demo, select the “UART” Protocol and set the “Baud Rate” to “19200”, then...
provide a connection name or click the “Assign name” button to have a name assigned by the system.

Step 3: Configure the I/O device tags. (This demo uses I-7055D, I-7018Z)

a. Right click the “Device” item in the “Workspace” tab, then select the “New Device” option.

b. Select “I-7000” from the “Device Series” dropdown menu and then select the created “UART” from the “Connection” dropdown menu.

c. Click the “Select” button to select the I/O module. (This demo uses I-7055)

d. Input the address number of the I-7055 module in the “Net ID” field. (This demo uses Net ID= 1.

Refer to Appendix B for more details)
e. Enter a device name or click the “Assign Device Name” button to have a name assigned by the system.

f. Repeat the steps above to add details for the I-7018Z I/O module (Net ID = 2).

---

Step 4: Create the light display/control. (This demo uses 8 DI/DOs)

a. Click the “Libraries” tab on the right hand side, and select the type of graphic (GUI) you want to use.

b. Select and drag the I/O tag you want to connect to from the left hand side into the frame.

c. Repeat the steps above to drag DI0 ~7 and DO0 ~7 into the HMI frame.
Step 5: Create the temperature display. (This demo uses I-7018Z ch0)

To display the temperature value, you can use either the height or width values of the “Slider” component to display the image as a rectangle, or choose the “Label” component to display the value numerically.

a. As shown in the following picture, click the “Widget (Ctrl+2)” heading to unfold the “Toolbox” panel, then select the “Slider” component. Move your mouse to the “Frame1” design area and click and drag a suitable sized rectangle.

b. In the “Properties Inspector” panel, you can change the background fill color (“BackgroundFillColor”), fill color (“FillColor”), outline color (“OutlineColor”), or set “Vertical” to “True” to set the value to be displayed from bottom up (“False” will display the value from left to right.).

c. Change the “Max” and “Min” field to match the maximum and minimum values for your temperature display.
d. Select the “TagName” browse button to enter the “Select variable” window. Click “Scope” to set the I/O Tag (This demo uses I-7018Z AI ch0).

e. Repeat the previous steps, and select the “Label” component from the “Toolbox” panel, draw a rectangle, edit its font and outline color properties, etc. in the “Properties Inspector” panel and assign a “TagName” (This demo uses I-7018Z AI ch0).

---

**Step 6: Set up the communication detectors. (This demo uses I-7055D and I-7018Z)**

a. As shown in the picture below, select two types of graphic (GUI) lights from the “Libraries”.

b. Select and drag the “I_7055_1_ERROR” and “I_7018Z_2_ERROR” items from the Workspace panel into the frame. (The light will turn on if there are any communication problems between the TouchPAD and the I/O modules.)

![Diagram showing the process of adding lights to the frame.]

---

**Step 7: Set up the button to switch frames.**

a. From the “Layout” menu, select the “New Frame” option and then check the “[2] SoftPLC” radio button and click “OK” to create a new LD frame.

![Diagram showing the process of creating a new frame.]

---
b. Select “BitButton” from the “Widget (Ctrl+2)” panel in the Toolbox, then click and
drag a rectangle in the “Frame1” window.

c. Edit the properties for the button in the “Inspector” panel. Set the “Reference” field
as “Frame2” and enter the label for the button in the “Text” field.

![Image of HMI with BitButton selected]

Step 8: Create the Text components.

Labels to describe the component can be created in the HMI frame as follows:

a. Select the “Text” item from the “Drawing (Ctrl+1)” panel in the Toolbox, and then click
in the frame wherever you want the description to be placed.

b. Enter the text to be displayed on the label in the “Text” field in the “Inspector” panel.

c. Change the “TextAsImage” option to “True” to enable the text to be displayed in the
local language (such as Chinese).

![Image of HMI with Text component selected]
Tips & Warnings

Note: If the “TextAsImage” option is set to “True”, the TouchPAD can display text in the local language (such as traditional Chinese, or any other language supported by MS Windows). The “Text” and “BitButton” items converted from text and displayed in image mode, so they will take more memory space.

Aligning multiple components
Select multiple HMI components by highlighting them with your mouse or press the “Shift” key and click multiple components, then select an align option from the “Layout” menu.

Step 9: Set up a background picture for Frame 2.

First, click the “Frame2” tab to switch frames.

a. Select the “Picture” item from the “Drawing (Ctrl+1)” panel in the Toolbox, and then click and drag a rectangle in the Frame2 window.

b. Edit the “Height” and “Width” properties in the “Inspector” panel to change the size of the picture. Edit the “Left” and “Top” properties to change the alignment position.

c. In the “Inspector” panel, click the “Picture” field or double click the box on the Frame2 to “Load” the picture from the “Select Picture” dialog box.
Tips & Warnings

a. Changing the “HiColor” property to “True” can improve the image resolution, but the file size will be increased at the same time.

b. You can create a picture using “Microsoft Paint”. Use Select All (Ctrl+A), then Copy (Ctrl+C), and then Paste (Ctrl+V) the picture into the HMI frame.

Step 10: Create the Virtual control button.

a. First, create a Virtual Tag by right clicking on the “Virtual” item in the “Workspace” panel and select “New Virtual Tag”, and then enter a variable name (e.g., V1) in the “Edit Variable” dialog box.

b. Create a “BitButton” by following the procedure described in Step 7b. In the “Inspector” panel, change the “Font” and “Text” items, then assign the variable “V1” to the “TagName” item (refer to Step 5d for details).
Step 11: Create the light displays.

Refer to the procedure described in Step 4 and create two light displays, and then assign the tags “I_7055_1_DO0” and “I_7055_1_DO1” in the “TagName” field in the “Inspector” panel for each component.

Step 12: Create a frame switch for Frame2.

Refer to the procedure described in Step 7 and create a frame switch for Frame 2. The easiest method is to copy and paste the frame switch from Frame1, and then change the “Reference” field in the “Inspector” panel to “Frame1” and edit the “Text” field to display an appropriate label.

The frame design is now complete. The next chapter will show you how to use the “Ladder Designer” feature to edit an LD program.
3.3.2 Editing an LD Program using “Ladder Designer”

In this demo, we use the “Light Control” button (V1) to control two lights (DO0 and DO1 from the I-7055D module).

**Step 1: Open the “Ladder Designer” program.**

a. In the design window for Frame2, select the “Light Control” button.
b. From the “HMI” menu, select the “Ladder Designer” option or press “F4” on your keyboard to open the “Ladder Designer” program.

**Step 2: Edit the LD program.**

a. Click the “F2” button or press “F2” on your keyboard to insert a “Contact”.
b. In the designer window, select the “Coil” item and then click the “F5” button or press “F5” on your keyboard to add a new Coil, as per the picture below.

**Step 3: Assign the variables.**

a. In the designer window, double click the “Normal Open Switch” item and select the variable “V1” from the “Name” field in the “Select Variable” dialog box.

b. Repeat the procedure to assign variables to the coils (I_7055_1_DO0/DO1).

**Step 4: Change the “Type” for both the switches and the coils.**

a. In the designer window, select the “V1 Switch” item and click the “Space [T]” button (or press either the “Space bar” or “P” on the keyboard) to switch the “Type” to “Positive (P)”.
b. Use a similar approach (except using the “S” on the keyboard instead of “P”) to switch the type of the Coils to “Set (S)”.

![Diagram](image)

Step 5: Create a second contact.
Using the same approach as the previous step, create another Contact with two Coils, but set the types to “Negative (N)” and “Reset (R)”, as per the picture below.

![Diagram](image)

**Description:**
When V1 is triggered from OFF to ON, the DO0 and DO1 of the I-7055D module are set to ON.
When V1 is triggered from ON to OFF, the DO0 and DO1 of I-7055D module are set to OFF.

Step 6: Save project.
The LD program is now complete. From the “File” menu, select the “Save & Close” option to save the project and exit the software.
3.3.3 Device Setup (TouchPAD)

Select “Set up Device (TouchPAD)” option from the “Run” menu to set up the download interface. Refer to Section 3.2.2 for more details.

Tips & Warnings

⚠️ The COM number used by your PC can be determined by accessing the “Device Manager” in the control panel on your PC.

3.3.4 Download the Project

Turn the Rotary Switch on the backplane of the TPD-280 to 1 (Update Mode) and reset the TPD-280, then select “Run” form the “Run” menu to compile, build and download the project to the TouchPAD. When finished, turn the Rotary Switch to 0 (Run Mode) and restart the device. (Refer to Section 3.2.3 for details)

Tips & Warnings

⚠️ How to speed up the response time of the components
  a. Select the “Refresh Time (I/O Scan)” option from the “HMI” menu.
b. Change the Refresh Time to an appropriate value.
3.4 Demo 3
(Multi HMI with ISaGRAF PAC: Light, Temperature, Communication Detector)

Using Demo 2, we have described how to establish an I/O connection and create components, and introduced the HMI Ladder Designer. The following is a brief introduction to Demo 3.

In Demo 3, two TPD-283 modules are linked to an ISaGRAF PAC (µPAC-7186EG, as a Modbus TCP Server) and are used to read/write to two I/O modules (M-7055D and M-7018Z) where the Modbus Tags are configured using an ISaGRAF program.

The components used in Frame1 are:
- Light display/control (M-7055D-DI/DO) x 8
- Temperature display (M-7018Z ch0) x 1
- Communication detector (µPAC-7186EG) x 1
- Control button x 2

**Tips & Warnings**

⚠️ Note: When using the DCON Utility to configure the M-7018Z, which uses the Modbus RTU protocol for the RS-485 Port of the M-7018Z to connect with the TouchPAD, set the “Dataformat” option to “Engineering” and the “Protocol” option to “Modbus RTU.”

⚠️ Note: If you use HMIWorks v2.02 or later, set the “Dataformat” option to “2’s complement”.

Refer to Appendix A and Appendix B for more information about how to download the driver for the I-7561 converter and the configuration of the digital/analog I/O modules.

Refer to Appendix D for more information about the ISaGRAF PAC (µPAC-7186EG) and ISaGRAF programs.

**Hardware Devices:**
Use two TPD-283 modules (Web type), a µPAC-7186EG server, an M-7055D module, and an M-7018Z module for Demo 3
Note: The “Ethernet” and “Power-over-Ethernet (PoE)” devices both use a normal Ethernet cable, but the PoE series can carry both data and power through the Ethernet cable.
3.4.1 HMI Frame Design

Step 1: Create a new TPD-283 project in the Ladder program. (Refer to Section 2.2 for more details)

![Image of TPD-283 project creation]

Step 2: Create a connection (TCP/IP). (Refer to the Step2 in Section 3.3.1 for more details)

Enter the IP address of the device (controller) that is connected to the TouchPAD (This demo uses a µPAC-7186EG server).

![Image of connection setup]

The IP Address for the uPAC-7186EG server
Step 3: Configure the I/O Tags.
(Device: µPAC-7186EG, refer to Step 3 in Section 3.3.1 for more details)

a. In the “Workspace” panel, right click on the “Device” item and select the “New Device” option.
b. In the “Devices” dialog window, set “Device Series” option to “Modbus TCP” and set the “Connection” field to the “TCP_204” item that you created in the previous step, and then press the “Edit” button.
c. The addresses of the Modbus Tags are pre-configured in the ISaGRAF program (DO0 ~ DO7 = 21 ~ 28; DI0 ~ DI7 = 01 ~ 08; AI0 ~ AI9 = 101 ~ 110. Refer to Appendix D for full details), so assign the appropriate address to the “StartAddress” and “Count” fields in the “Import…” dialog box, and then enter a “Device Name”.

Step 4: Set up a background picture for your frame.

Follow the same procedure as that described in Step 9 of Section 3.3.1 in Demo 2 to create and set up a background picture for your frame.

* Picture size: 320 (Width) x 240 (Height)
Step 5: Create the light display/control.

Follow the same procedure as that described in Step 4 of Section 3.3.1 in Demo 2 to create eight DI/DO lights.

Step 6: Create the temperature display. (This demo uses AI0)

Follow the same procedure as that described in Step 5 of Section 3.3.1 in Demo 2 to create a “Slider” component (Set the Max value to 1000, as the reading of the K-type thermocouple sensor (wire) only allows 3 digits to be displayed for the Modbus I/O) and a “Label” component (“TagName”= AI0) to display the temperature value.
Tips & Warnings

The M-7018Z for K-type thermocouple sensor only allows for a single decimal place, so in this case, the value 269 means 26.9 degrees Centigrade. If the decimal point needs to be displayed, refer to Appendix E for details of how to achieve this.

Step 7: Create the communication detector.

Follow the same procedure as that described in Step 6 of Section 3.3.1 in Demo 2 to create a communication detector for the µPAC-7186EG.

Step 8: Create the Virtual Tags (V1, V2)

Follow the same procedure as that described in Step 10 of Section 3.3.1 in Demo 2 to create two Virtual Tags, V1 and V2.

Step 9: Create a Check Box for the “All ON/OFF” switch button.

a. As shown in the picture below, select the “CheckBox” item from the “Widget (Ctrl+2)”
panel in the Toolbox and then click and drag a rectangle in the Frame1 window.

b. In the “Inspector” panel, set the “TagName” variable to “V1” and change the color and font items to the desired values.

(Note: The Ladder program for this demo will be introduced in the next section.)

Step 10: Create another Check Box for the “Saving Mode” switch button.

Follow the procedure described in the previous step to create another “CheckBox” and set its “TagName” variable to “V2”.

---

Copyright@ 2012 ICP DAS CO., LTD. All Rights Reserved. E-mail: service@icpdas.com
3.4.2 Using “Ladder Designer” to edit an LD Program

This section will introduce the Ladder program for the “All ON/OFF” and “Saving Mode” switches that were created in the previous section.

**Step 1: Open the “Ladder Designer” program.**

From the “HMI” menu, select the “Ladder Designer” option or press “F4” on your keyboard to open the “Ladder Designer” program.

**Step 2: Edit the “All ON/OFF” Ladder program.**

a. Click the “F2” button or press “F2” on your keyboard to insert a Contact.

b. In the designer window, select the Coil item and then continue to click the “F5” button or press “F5” on your keyboard to add 7 more Coils.

c. In the designer window, double click the switch item and assign the variable “V1”. Repeat the process for the Coil items, assigning the variables “DO0 ~ DO7”.

d. Click on the 1st rung and then select the “Duplicate” option from the “Edit” menu or press “Ctrl+D” on your keyboard to copy a rung below the 1st rung.

e. In the designer window, select the 1st rung, then click the “Space [T]” button or press
either the “spacebar” or “P” on the keyboard to change the type for “V1” to “P” (Positive). Repeat the procedure to change the Coil types to “S” (Set). (Refer to Step 4 of Demo 2 in Section 3.3.2 for more details)

f. In the designer window, select the 2nd rung, then click the “Space [T]” button or press either the “spacebar” or “N” on the keyboard to change the type for “V1” to “N” (Negative). Repeat the procedure to change the Coil types to “R” (Reset).

Step 3: Edit the “Saving Mode” Ladder program.

Description: When clicking this button, the lights for DO5~7 will turn on and the lights for DO0~4 will turn off. Clicking the button for a second time will turn off all the lights.

a. Using the same procedure as that described in Step 2, create the rungs for the “V2” Switch and Coils. (3rd and 4th rungs)

b. In the designer window, select the 3rd rung, then click the “Space [T]” button or press either the “spacebar” or “P” on your keyboard to change the type for “V2” to “P” (Positive). Repeat the procedure to change the types for DO0~4 to “R” (Reset) and DO5~7 to “S” (Set).

c. Use the same procedure as described in b to set the types for the 4th rung, but set the “V2” Switch to “N” (Negative) and the Coils to “R” (Reset).
3.4.3 Device Setup (TouchPAD)

The project design is now finished and is ready to be downloaded to the TouchPAD. In Demo 3, there are two Web series TouchPAD (TPD-283) device that must be configured and have an IP assigned before downloading the project.

The default settings for the TPD-283 are “IP = 192.168.255.1”, “Gateway = 192.168.0.1” and “Mask = 255.255.0.0”, as indicated on the label of the shipping container. Of course, these settings may not be suitable for every environment and may need to be changed. First, make sure that the hardware network is connected (refer to Section 3.4 – Hardware Devices), and then search for the TPD-283 device and set up the IP. Note: Only one TouchPAD device can be configured at any one time.

Step 1: Set up the TouchPAD IP

a. Select the “Setup Device (TouchPAD)” option from the “Run” menu to enter the “Setup Ethernet Device” window.
b. Click the “Search TouchPAD…” button to search for the TouchPAD on the network. If your TPD-283 is being set up for the first time or it is on a different sub-domain, move the rotary switch position to 1 and reset the TPD-283, then begin the search again. This will take about 40 seconds, and then IP = 0.0.0.0 will be displayed.
c. Double click the IP field for the device to begin the setup process.
d. Use the MAC Address that is displayed on the back panel of the TPD-283 to identify the device module.

Set up the device as the picture below:
“Host IP Address” (PC): IP Address of the PC where HMIWorks is installed
“Device IP Address” (middle): IP Address for the TouchPAD
“Device IP Address” (bottom): IP Address used for downloading only

![Setup Ethernet Device](image)

**The IP Address must be in the same sub-domain.**

**Tips & Warnings**

![Alert Icon]

Note: If the IP Address for the TouchPAD is set as “DHCP”, you will need to wait for a while for the DHCP server to assign an IP Address to the TouchPAD. The IP settings are saved in the project, NOT in the TouchPAD, so the IP Address for the TPD-283 will not work until the project has been successfully downloaded.

**After completing this step, please go to the next section for a description of how to download the project before setting up the second TouchPAD.**

The HMIWorks software can only configure one TouchPAD at a time. If you replace an existing TouchPAD (Ethernet version), you must
execute the "Setup Device (TouchPAD)" procedure to search for TouchPAD again.

e. Follow the same procedure that described above to set up the second TPD-283 device. For example:

“Device IP Address” (middle): set to “192.168.1.203” and select “Static IP”

“Device IP Address” (bottom): set to “192.168.1.205”

3.4.4 Download the Project

The rotary switch should have been moved to the “1” position and the device restarted if the procedure described in the previous section “3.4.3 Device Setup” was followed correctly. Ensure that this has been done and select the “Run” option from the “Run” menu to compile and download the project to the TouchPAD device. (Refer to Steps 2 and 3 in Section 3.2.3 for further details. When downloading the project for the first time, a period of about 20 seconds will elapse before the download process begins.
Important Note: The rotary switch of the TPD-283 should only be moved to the Mode 1 position when setting the IP Address for the first time or if the project download fails. In all other situations, please ensure that the switch is in the Mode 0 position and restart the device. Before downloading the project, execute “Device Setup” and click the “Run” option from the HMIWorks “Run” menu to compile and download the project. The device will restart automatically.
3.5 Demo List

We have introduced you four demos (The top four items in the table below) in the previous chapter. From now on, we will continually add demos in following table to help users understand the HMIWorks software for their first-time usage.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Demo_00** | Using the TPD-280 device (programmed by the LD Language)  
To create a button to sound a beep and increase the counter by “1” when clicked and the counter is reset to 0 whenever it reaches 10. |
| **Demo_01** | Using the TPD-280 device (programmed by the C Language)  
To create a button to sound a beep and increase the counter by “1” when clicked. Then, create a timer to automatically increase another counter by “1” (from 0 to 100) and when the second counter reaches 100, it starts from 0. |
| **Demo_02_LD** | Using the TPD-280 device (programmed by the LD Language)  
To communicate with the I-7055D module and the I-7018Z module via the RS-485 network to implement the function of light control, temperature display and communication status detection. |
| **Demo_03_LD** | Using the TPD-283 device (programmed by the LD Language)  
To communicate with the µPAC-7186EG server, the M-7055D module and the M-7018Z module via the TCP/IP network and implement the function of light control, temperature display and communication status detection. |
| **Demo_04_C** | Using the VPD-130 device (programmed by the C Language)  
To read the values of both date and time of the µPAC-7186EG server via the RS-485 network. (ISaGRAF FAQ-147) |
| **Demo_05** | Using the TPD-430 device (programmed by both the LD Language and the C programming language)  
To display “Hello World” on a Label when clicking a button in the first page. And to implement on the second page the controlling of the M-7055D module and the M-7018Z module via the RS-485 network for DI/DO and temperature display. |
Appendix A. Downloading Information

This manual is only a brief introduction to the TouchPAD functions. Please visit the following websites for more detailed information about the TouchPAD series.

User Manual:

Products Website:

Products Datasheets:

Download I-7561 (USB to RS-485 converter) Driver:

I-7000 I/O Modules (Support for the DCON Protocol) :
http://www.icpdas.com/products/Remote_IO/i-7000/i-7000_list.htm

M-7000 I/O Modules (Support for the Modbus RTU & DCON Protocols) :
http://www.icpdas.com/products/Remote_IO/m-7000/m-7000_list.htm

ISaGRAF Website :
http://www.icpdas.com/products/PAC/i-8000/isagraf.htm
Appendix B. Configuring the I/O Module

This appendix describes how to use the DCON Utility to configure the Address, Net ID, Baud Rate and Data format for the I/O module.

The DCON Utility and the user manual can be downloaded from the following website: 

Hardware Wiring

PC

I-7561 (USB/RS-485 Converter)

Power Supply (DP-665, 24V)

I-7055D
(8 DI, 8 DO Module)

I-7018Z-G/S (10-ch Thermocouple Input Module with High Voltage Protection)

Note: Only one module can be set up at a time.

Baud Rate: 19200
Checksum: Disabled

Power

RS-485
(Data+, Data-)

RS-485
(Data+, Data-)

NET-ID (Address): 1

NET-ID (Address): 2

I-7055D
(8 DI, 8 DO Module)

Software Installation

Double click the installation software icon and continuing pressing “Next” to complete the installation.
I/O Configuration

I-7055D:

a. First, move the switch on the back of the I-7055D to “Init” mode, and reset the module.

b. Run the “DCON Utility” from the icon on the desktop or from the Start menu: “Start” > “All Programs” > “ICPDAS” > “DCON_Utility” > “DCON_Utility”.

c. Click the “COM Port” menu to set up the options, and click the “Start Search” button.

d. With the I-7055D module in INIT mode, click “7055D” in the module field to display the configuration window.
e. Set the Address to 1, the Baud rate to 19200, and click the “Settings” button, and then the following message will be displayed. Click the “OK” button to continue.

![Setting Communication Parameters OK](image)

f. Switch the I-7055 to “Normal” mode and reset the module, then search for the module again to confirm the configuration.

![Configuration Settings](image)

M-7055D:
The settings are similar to those of the I-7055D, but the “Protocol” option should be set to “Modbus RTU”.

I-7018Z:
Refer to the previous steps when configuring this module. (As per the picture below)
Configuration Settings:
Address = 2, Baud Rate = 19200, Data Format = Engineering
Channel Enable/Disable Settings:
Take the channel one for example, and set the CH0 to “T/C K-type”.

---

TPD/VPD Series - Getting Started v.1.0.5

Copyright © 2012 ICP DAS CO., LTD. All Rights Reserved. E-mail: service@icpdas.com
Tips & Warnings

Note: The “T/C ?-type”, with the wire opening detection feature, cannot be selected when the channel is not being used. As shown in the picture below, if the field (background is yellow) of the “Channel Enable/Disable Setting” part shows “+9999.900”, it means that the “Input Range” settings are wrong, or the channel is set as a “T/C ?-type”, but is not being used. Note that every channel must be checked.

M-7018Z:
The settings are similar to those of the I-7018Z, but the “Protocol” option should be set to “Modbus RTU”.

Note: If the RS-485 Port of the TouchPAD uses the Modbus RTU protocol to connect to the M-7018Z, then the M-7018Z must be set to "Engineering" mode.
(Modbus RTU).

Note: If you use HMIWorks v2.02 or later, please set the “Data Format” parameter to “2’s complement”.
Appendix C. Creating Your Own GUI

The HMIWorks Libraries provide many images and icons for integration into the GUI (Graphical User Interface), and users can also create their own custom GUIs.

a. First, open an image file in MS “Paint”, then click the toolbox to select the entire image (or press Ctrl+A on the keyboard) and then choose the copy option from the “Edit” menu (or press Ctrl+C on the keyboard) to copy the picture.

b. Select the Paste option from the HMIWorks “Edit” menu (or press Ctrl+V on the keyboard) to paste the image to the HMI frame, then right click on the image and select “Add to library...” from the popup menu. Enter a name, such as “L04_0” (In this example, the light has two states: 0 means OFF, 1 means ON), as per the examples below.

c. Follow the same procedure to create a second image for the ON state (L04_1).
Appendix D. Configuring and Programming the ISaGRAF PAC

This chapter introduces the ISaGRAF program and the ISaGRAF PAC used with the TouchPAD implemented in Demo 3 (Section 3.4).

ISaGRAF PAC Configuration:
The µPAC-7186EG settings used in Demo 3:
- COM2: Master
- Baud Rate: 19200
- IP: 192.168.1.204
- Mask: 255.255.255.0

Refer to the µPAC-7186EG getting started (Sections 3.7 and 3.8) for details of the configuration process:

ISaGRAF Variables:

<table>
<thead>
<tr>
<th>Variable Name</th>
<th>Address (Hex &gt; Decimal)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>R7055_DO01 ~ 08</td>
<td>0015 ~ 001C ➞ 21 ~ 28</td>
<td>M-7055D - DO0 ~ 7</td>
</tr>
<tr>
<td>R7055_DI01 ~ 08</td>
<td>0001 ~ 0008 ➞ 1 ~ 8</td>
<td>M-7055D - DOI ~ 7</td>
</tr>
<tr>
<td>R_7018Z01 ~ 10</td>
<td>0065 ~ 006E ➞ 101 ~ 110</td>
<td>M-7018Z - A10 ~ 9</td>
</tr>
</tbody>
</table>
ISaGRAF Program Description:

Reading 8 Booleans from the Modbus device:

ID = 1
Read from Modbus 0
Format: Bit

Return:
OK: True
Fail: False

Converting 1 Word (Signed 16-bit) to 16 Booleans:
Writing 8 Booleans to the Modbus device:

Return:
OK: True
Fail: False

Reading 10 Words (Signed 16-bit) from the Modbus device:

Return:
OK: True
Fail: False
Appendix E. Displaying the Decimal Point

The numbers used in the “Ladder Designer” are displayed in integer format without decimal digit. In some case, you may need to calculate or display the decimal. This appendix introduces how to display the decimal point for the thermocouple input modules, I-7018Z (DCON protocol) and M-7018Z (Modbus protocol).

I-7018Z Module

The “Ladder Designer” displays the received value only the integer part, ignore the decimal part (ex. 26.500 → 26). But you can display the decimal, such as “26.5”, by changing the “IO.hsf” file of the module. The “IO.hsf” of I-7018Z is in the directory: C:\ICPDAS\HMIWorks_Standard\bin\Modules\I-7000\I-7018Z. Change it as below:

```c
if (VAR_VALUE($ENABLE_AI) && VAR_VALUE($R_ACTION))
{
    v_ai[0] = v_ai[0] * 10;
    VAR_SET($a10, v_ai[0]);
    VAR_SET($a11, v_ai[1]);
    VAR_SET($a12, v_ai[2]);
    VAR_SET($a13, v_ai[3]);
}
```

Add one line: `v_ai[0] = v_ai[0] * 10;` so, AI0 value is “265” now.

Then, in HMIWorks, set the “DecimalDigits” of “Label” as 1 to display one decimal digit (26.5). Besides, the AIO value is changed from 26 to 265 now, the “Max” property must be changed to 1000 also if you use the Slider. Remember compile the project and download to the TouchPAD again.
M-7018Z Module

Please refer to the product website for details of the temperature input range, and refer to Section 3.5 “Engineering Data Format Table” of the M-7018Z module manual for details of the maximum number of decimal digits allowed for each input type.

The Modbus protocol uses 2 bytes to access the data value, so the range value is \(-32768\) ~ \(+32767\). As shown in the table below, when the input range is enlarged by \(10^n\) times, “n” is the decimal digit in the display value. Taking the K-Type as an example, if the input value is 26.500, the displayed value will be 265 (enlarged by \(10^1\) times).

<table>
<thead>
<tr>
<th>Input Type</th>
<th>Input Range</th>
<th>Display Range</th>
<th>Max. Decimal Digits</th>
</tr>
</thead>
<tbody>
<tr>
<td>J</td>
<td>-210 ~ +760</td>
<td>-2100 ~ +7600</td>
<td>1</td>
</tr>
<tr>
<td>K</td>
<td>-270 ~ +1372</td>
<td>-2700 ~ +13720</td>
<td>1</td>
</tr>
<tr>
<td>T</td>
<td>-270 ~ +400</td>
<td>-2700 ~ +4000</td>
<td>1</td>
</tr>
<tr>
<td>E</td>
<td>-270 ~ +1000</td>
<td>-2700 ~ +10000</td>
<td>1</td>
</tr>
<tr>
<td>R</td>
<td>0 ~ +1768</td>
<td>0 ~ +17680</td>
<td>1</td>
</tr>
<tr>
<td>S</td>
<td>0 ~ +1768</td>
<td>0 ~ +17680</td>
<td>1</td>
</tr>
<tr>
<td>B</td>
<td>0 ~ +1820</td>
<td>0 ~ +18200</td>
<td>1</td>
</tr>
<tr>
<td>N</td>
<td>-270 ~ +1300</td>
<td>-2700 ~ +13000</td>
<td>1</td>
</tr>
<tr>
<td>C</td>
<td>0 ~ 2320</td>
<td>0 ~ 23200</td>
<td>1</td>
</tr>
<tr>
<td>L</td>
<td>-200 ~ +800</td>
<td>-2000 ~ +8000</td>
<td>2</td>
</tr>
<tr>
<td>M</td>
<td>-200 ~ +100</td>
<td>-20000 ~ +10000</td>
<td>1</td>
</tr>
<tr>
<td>L (DIN43710)</td>
<td>-200 ~ +900</td>
<td>-2000 ~ +9000</td>
<td>1</td>
</tr>
</tbody>
</table>

Therefore, the temperature value “265” displayed on the TouchPAD is actually “26.5”. To display this value correctly, you need to change the “DecimalDigits” parameter for the relevant “Label” in HMIWorks to 1, then compile and download the project to the TouchPAD again. Once amended, the TouchPAD will display the decimal value correctly.
Appendix F. Using USB to Download a Program

All the TPD-280U, TPD-430, TPD-430-EU, VPD-130, VPD-130N devices contain a USB Port. After completing the HMIWorks project, and **without** having to click the “Setup Device” option from the “Run” menu, the user only needs to download the program to the TouchPAD **via the USB port**.

**Note:** If HMIWorks version 2.03 or above has been already installed on your PC, the TouchPAD USB driver has also been automatically installed, too. However, users may need to update the TouchPAD USB driver if some previous version of HMIWorks was installed.

**Install/Update the TouchPAD USB Driver**

**Step 1: Prepare the TouchPAD**

Turn the Rotary Switch on the TouchPAD to Mode “9”. When the “Waiting for connection...” message is displayed on the TouchPAD screen, connect a USB cable from the TouchPAD to the PC.

**Step 2: Run Hardware Update Wizard**

**In the** “Hardware Update Wizard” dialog box, do not allow Windows to connect to “Windows Update” to search for software. Select “No, not this time” and click the “Next” button.
Tips & Warnings

Note: If your PC has a different OS installed, you may need to use a different installation procedure. If the “Hardware Update Wizard” dialog box is not automatically displayed, please go to the “Device Manager” and right click on the appropriate device name and select “Update Driver...” (Windows XP) or “Update Driver Software...” (Windows 7) to install the driver.

Windows XP:

Windows 7 (32 bit):
Step 3: Update Drivers

Select “Install from a list…. (Advanced)” and click the “Next” button.

Step 4: Select the install options

Select “Search for the best driver…” and check the “include this location…” checkbox, then press the browse button to install the driver from the following location:

C:\ICPDAS\HMIWorks_Standard\Tools\USB_Drivers

Click the “Next” button to continue.
Step 5: Completing installation

Once the driver is successfully installed, the following screen will be displayed.

Click the “Finish” button to complete the installation process.

**Download the Program via the USB Port**

After downloading the USB driver as described in the previous step, restart the TouchPAD and the following screen will be shown. The download process can then begin.

In the “HMIWorks” Utility, select the “Run” option from the “Run” menu to download the program to the TouchPAD.
When the TouchPAD screen shows that downloading is “100%” complete, turn the Rotary Switch to Mode “0” and restart the TouchPAD. The new program will be executed in “Run” mode.